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l
l
l

Software Version number, which indicates the software version.
Document Release Date, which changes each time the document is updated.
Software Release Date, which indicates the release date of this version of the software.

To check for recent updates or to verify that you are using the most recent edition of a document, go to: https://softwaresupport.hp.com/.
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What's new in this release
This section describes the important changes in this release.
Tip: The following knowledge base article contains links to all the previous 9.4x release notes and
patches. This article enables you to always find the most up-to-date release notes and the latest
9.4x patches.
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01384297

Supported items
HP Service Manager 9.41P2 includes the following certification changes.

Added support
Support has been added for the following item.
Mobility client
l

iOS 9

Discontinued support
Support for the following item has been discontinued.
Web tier and Service Request Catalog
l

Internet Explorer 10
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Enhancements
This release includes the following enhancements. The following tables include all enhancements that
were implemented after the release of Service Manager 9.41P1.

Web client
CR

Summary

QCCR1E129149 To-Do Alerts are now automatically acknowledged when you click a link in the alert

Mobility
CR

Summary

QCCR1E128757 The Mobility client now supports iOS9

HP Service Manager (9.41)

Page 6 of 58

Fixed defects
This release fixes the following defects. The following tables include all fixes that were implemented
after the release of Service Manager 9.41P1.

Applications
CR

Summary

QCCR1E129332 Values cannot be entered in fields that are made from a global list

Mobility
CR

Summary

QCCR1E118816 You receive a "Request failed" message when your Mobility client user session
times out
QCCR1E129373 Mobility client sessions are not cleaned up as expected after the sessions time out

SRC
CR

Summary

QCCR1E126562 SRC does not simultaneously support PD requests and non-PD quotes
QCCR1E127429 Text in the Survey Detail pane is not displayed correctly in Arabic and Hebrew
versions of SRC
QCCR1E130115 You receive an error message when you remove a denied approval status catalog
from a request approval record and then resubmit the request
QCCR1E130349 Service and support request counts are zeroed when you click the browser refresh
button in SRC
QCCR1E130499 Cannot view the subscription details page when you open SRC in Hebrew
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Server
CR

Summary

QCCR1E104801 Error message when you perform a mass update of incidents that removes records
from the QBE
QCCR1E129582 "...SM/RUN/headless': File exists" error message when you run an "sm" command

Web client
CR

Summary

QCCR1E127610 A "Failed to get history message" message is displayed when the conversation
history contains messages from Openfire or Lync
QCCR1E127664 Opened conversations that are saved in local storage are lost when you refresh the
web client
QCCR1E127870 The logout window is not displayed when you cancel a logout operation and then
click Logout again
QCCR1E127881 Nothing receives the focus after you cancel a logout operation
QCCR1E128211 The calendar bar disappears from the calendar page after you click the < or >
button in high contrast mode
QCCR1E128209 The arrow icon next to column headers is not highlighted in high contrast mode
QCCR1E128688 The "Show Next 50" and "Show All" buttons do not work in Internet Explorer
QCCR1E129304 Page navigation buttons on the Calendar widget are not clearly displayed in high
contrast mode
QCCR1E129303 The menu list for "Select Favorite" is not displayed in the Calendar widget in high
contrast mode
QCCR1E129302 The current day on the calendar is not highlighted in high contrast mode
QCCR1E129504 JAWS does not read out the state of checkboxes for selected columns in the ToDo
queue
QCCR1E129677 When you press the down arrow key while the focus is on a comfill box, the focus
skips an item
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CR

Summary

QCCR1E130079 The button that is in focus is not highlighted in high contrast mode
QCCR1E130081 The left-hand border of the group section banner is not displayed in high contrast
mode
QCCR1E130214 When you view the web tier in high contrast mode, the selected day in the date
picker dialog box is displayed in the same style as the unselected days
QCCR1E130624 Autocomplete becomes case sensitive when you enter text in a combo box
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Known issues, limitations, and workarounds
This release has the following known issues and limitations. This is a cumulative list of known issues and
limitations in Service Manager, including those that are already documented in previous release notes
(Service Manager 9.40 and patches, and Service Manager 9.41 and patches).

Known issues
Global ID

Issue

Workaround

QCCR1E130718 When you rotate the screen of an iOS9-based
device to landscape and then back to portrait,
the Mobility client page is incorrectly
displayed.

To work around this issue, refresh
the browser.

QCCR1E128546 On a virtual machine with Interl(R) Core(TM)2
Duo CPU T7700 @2.40 Ghz, 2.59 GHz
(4Processors), a memory leak occurs on the
http connector server.

There is currently no workaround
available.

QCCR1E128412 On Unix platforms, the legacy listener does
not work if Service Manager server uses the
Oracle 12c instant client.

There is currently no workaround
available.

QCCR1E124820 After you add the "Service Display Name" field
to a Change view and specify the "Service"
field as a group-by field, an error occurs and
the view does not load when you sort the view
by Service Display Name.

Add either the “Service” field or
the “Service Display Name” field to
both the view and the list of groupby fields.
Note: The “Service” field is
preferred because this field is
populated with CI Display
Name values. There is no need
to add the second level field,
Service Display Name.

QCCR1E127867 The "Chart by" functionality does not work
when there is an outer join field in the view.

Use Service Manager Reports
instead.

QCCR1E127873 In the Service Manager (SM) Hybrid mode,

Make a call to the API after you set

HP Service Manager (9.41)
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Global ID

Issue

Workaround

calling the SM RESTful API for UCMDB
integration for the first time will fail.

up the SM Hybrid environment.

QCCR1E127871 In the "Chart by" form,
"sm.device.display.name" is displayed as the
value of the "Display Name" column.

There is currently no workaround
available.

QCCR1E127858 The index status is not updated into the
Knowledge Management knowledge base, and
thus the library cannot be searched in the
main search page and the context-aware
page.

Drill down into the Knowledge
Maintenance page for the library
to synchronize the index status
into the Knowledge Management
knowledge base.

QCCR1E127872 The IDOL content service does not start on
machines that have 24 CPU cores configured.

You can apply a workaround if the
following error appears in the
application.log of the content
server:
[1] 70-Error: Error: Attempt
to open [ =…)0] failed. (No
such file or directory). The
file open mode [rb] does not
permit creation of a new
file.
In this case, modify the following
parameters in the configuration of
the content server, and then
restart the content server.
[Server] Threads=x [AsyncActions]
Threads=y let x+y<32

QCCR1E127858 The new library index status is not updated in
the "kmknowledgebase" table when you click
Full Reindex in the Knowledge Maintentance
page.

Refresh the status in library
configuration.

QCCR1E127861 The logical.name of the CI is displayed on the
"Edit OO flow" widget for Emergency Change
records in the "Build and Test" phase.

There is currently no workaround
available.

QCCR1E126469 Chrome 44 refuses to send https requests to
a web server with a self-signed SSL
certificate. Additionally, you receive the
following error message:

Use Chrome 43 instead.

HP Service Manager (9.41)
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Global ID

Issue

Workaround

Failed to load resource: net::ERR_
INSECURE_RESPONSE
Since all requests are blocked, the web server
terminates the user session after a while and
the user is logged out.
QCCR1E124206 Service Manager survey does not support
multiple company.

There is currently no workaround
available.

QCCR1E124149 Record that do not satisfy query conditions
for selected lines are displayed in the
calculation chart report.

There is currently no workaround
available.

QCCR1E124144 You cannot drill down into the calculation and
duration charts when the aggregator is set to
MIN or MAX.

There is currently no workaround
available.

QCCR1E124821 Auto-complete does not work when the link
There is currently no workaround
line of the associated field has the "Skip Query available.
Rewriting" option enabled.
QCCR1E122174 SMC does not support RTL.

There is currently no workaround
available.

QCCR1E124466 Error messages displayed in English are not
indexed in localized language versions.

There is currently no workaround
available.

QCCR1E125500 If you enable the
preventDuplicatedAttachmentName parameter
in web.xml and then upload the same file
twice, an error message is not displayed in the
Internet Explorer and Chrome browsers.

There is currently no workaround
available.

QCCR1E126359 English text in screenshots is not recognized
correctly when your contact language is
Arabic.

There is currently no workaround
available.

QCCR1E119401 If you enable the
preventDuplicatedAttachmentName parameter
in web.xml and then upload the same file
twice, an error message is not displayed in the
Internet Explorer and Chrome browsers.

There is currently no workaround
available.

QCCR1E121838 Labels overlap on Stacked Horizontal bar
charts in Reports.

There is currently no workaround
available.
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Global ID

Issue

Workaround

QCCR1E122115 Values less than 0 are not displayed correctly
in bar or area charts.

There is currently no workaround
available.

QCCR1E125879 The additional Request Overview (PD) (Global)
dashboard and its reports are displayed in
Classic mode.

There is currently no workaround
available.

QCCR1E122716 You cannot drill down into the index for fsylib.

There is currently no workaround
available.

QCCR1E127170 You cannot tailor OO flows.

There is currently no workaround
available.

QCCR1E123090 Special characters cannot be searched for in
IDOL.

There is currently no workaround
available.

QCCR1E123438 An error message with an unclear meaning is
displayed when the OMNI Group Server is
offline.

There is currently no workaround
available.

QCCR1E124369 Some returned results from external libraries
are not highlighted.

There is currently no workaround
available.

QCCR1E124633 When you set all Index Weight values to “No
There is currently no workaround
Index” and then click Save, the configuration is available.
saved incorrectly.
QCCR1E126198 The Smart Search Configuration tab is
incorrectly named “environment: knowledge
management”.

There is currently no workaround
available.

QCCR1E126737 Links in the file system search results do not
open in Firefox or Chrome.

There is currently no workaround
available.

QCCR1E126780 The pagination count is not correct in the
main search page.

There is currently no workaround
available.

QCCR1E126842 The “Set parent” button in Smart Search
should not be shown for non-Process
Designer-based Incidents.

There is currently no workaround
available.

QCCR1E126847 The reported number of search results from
the catalog library is not correct.

There is currently no workaround
available.

QCCR1E126848 SharePoint pages are indexed into IDOL
incorrectly.

There is currently no workaround
available.
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Global ID

Issue

Workaround

QCCR1E126852 Type ahead cannot use the display value of a
global list in the advanced filter function in
Smart Search.

There is currently no workaround
available.

QCCR1E126886 The Change Service value does not display the
CI Display Name.

There is currently no workaround
available.

QCCR1E126901 Preconditions should be merged if there are
multiple preconditions for a file, but the
criteria conflict.

There is currently no workaround
available.

QCCR1E126974 The reported number of search results is
incorrect.

There is currently no workaround
available.

QCCR1E126978 You cannot select the ID-title in Smart Search
in Internet Explorer 10.

There is currently no workaround
available.

QCCR1E127031 No error message is displayed in the library if
the attachment is not indexed successfully.

There is currently no workaround
available.

QCCR1E127368 If you use fields that are not in the form in the
match criteria of a predefined filter in Smart
Search, Smart Search does not work.

Add the fields used in the match
criteria of the predefined filter in
context aware search into the
form of the current working ticket.

QCCR1E127036 The filter is saved too slowly when you click
“search within results” in Internet Explorer 10.

There is currently no workaround
available.

QCCR1E124715 You cannot connect to IDOL with an IPv6
address.

There is currently no workaround
available.

QCCR1E124520 On a tablet, the back and forward buttons do
not work correctly in IDOL external webpage
details pages.

There is currently no workaround
available.

QCCR1E125084 The number of search results changes after
you click to view the next page.

There is currently no workaround
available.

QCCR1E126163 In the HS environment, locked sessions cannot
be killed from the Show Locks format
(system.status.locks.g).

There is currently no workaround
available.

QCCR1E125549 If there is 127.0.0.1 in the hosts file, the
hostname is displayed as
"localhost.localdomain" in the result of the
command "sm -reportlbstatus".

There is currently no workaround
available.
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Global ID

Issue

Workaround

QCCR1E127029 The average response time of the "src01_02_
search" transaction is more than 2s in 9.41,
compared to that of 0.8s in the previous
release.

There is currently no workaround
available.

QCCR1E125884 The old Knowlege Management search icon is
still displayed.

There is currently no workaround
available.

QCCR1E127213 The "Content1" service cannot be started by
the "Start Service" function in the IDOL
installer.

There is currently no workaround
available.

QCCR1E121838 In the "Stacked Horizontal bar" report, the
value label is truncated.

There is currently no workaround
available.

QCCR1E125879 An additional Request Overview (Global)
dashboard and its reports are displayed in the
Classic mode.

There is currently no workaround
available.

QCCR1E122716 Users cannot drill down into index for fsylib
links.

The fsyslib link refers to URLs with
the "file://" protocol in search
results. However, Firefox and
Chrome do not open such links
when they are clicked in the result
page or in the pages that are
originated from outside the local
machine. This is a design decision
made by those browsers to
improve security. Internet Explorer
supports this functionality by
default.

QCCR1E123433 The display name is not displayed in the mass
update interface. Instead, only the logical
name is displayed.

There is currently no workaround
available.

QCCR1E120454 The datadict record cannot be saved when the
display name is changed.

There is currently no workaround
available.

QCCR1E127326 UCMDB federation is blocked.

There is currently no workaround
available.

QCCR1E126189 The detail page is not synchorized with the tab There is currently no workaround
on BlackBerry.
available.
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Global ID

Issue

Workaround

QCCR1E127624 Data unloaded from the SQLSERVER
NVARCHAR database cannot be loaded into
the Oracle database.

There is currently no workaround
available.

QCCR1E122190 If you set a fuzzy search condition before, the
comfill box that has the reference table
setting on displays an empty list.

There is currently no workaround
available.

QCCR1E119964 When a new record is added in dbdict, the
alias of type is not removed and the alias for
display.name is not created.

There is currently no workaround
available.

QCCR1E120414 Logical name, instead of display name, is
displayed.

There is currently no workaround
available.

QCCR1E121852 The Fill button does not work if the values of
the "diaplay list" and "value list" are set in
Windows client.

There is currently no workaround
available.

QCCR1E122160 The comfill control of the CI in the "Add Filter
Criteria" wizard does not work.

There is currently no workaround
available.

QCCR1E123135 The CI Display Name is not displayed on the
"Asset Allocation" form.

There is currently no workaround
available.

QCCR1E123311 An "No Record Found" error is displayed when
characters are deleted from the end of the
value filled by the auto complete functionality.

There is currently no workaround
available.

QCCR1E123536 The logical.name of the CI is displayed for the
"Create Template from Record" interface of
an incident record.

There is currently no workaround
available.

QCCR1E123716 The order is not correct for CI Name in the
pivot table.

There is currently no workaround
available.

QCCR1E124360 A tab cannot be closed in the dialog mode.

There is currently no workaround
available.

QCCR1E124423 Reference cannot be set on the member of an
array of a structure.

There is currently no workaround
available.

QCCR1E124820 The view is broken if you sort a field that has
been a group field.

There is currently no workaround
available.

QCCR1E125032 The style of the popup window is lost when the
session is refreshed.

There is currently no workaround
available.
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Global ID

Issue

Workaround

QCCR1E125204 When the Affected CI in the cross table is
exported as a list, the logical name is
displayed.

There is currently no workaround
available.

QCCR1E126003 No validation is done when you input an invalid
CI in a service level target.

There is currently no workaround
available.

QCCR1E126006 The logical name of a CI is displayed in the
"Additional Properties" tab in a Request task.

There is currently no workaround
available.

QCCR1E127712 An "invalid CI" error message is displayed
when you select the CI through the auto
complete functionality.

There is currently no workaround
available.

QCCR1E121670 The value of the comfill control is not restored
if it is an array list in the change record.

There is currently no workaround
available.

QCCR1E127303 Chinese characters sent from Lync are
displayed as "????" in Service Manager
Collaboration.

There is currently no workaround
available.

QCCR1E127732 The page is hung after you fill the incident
subcategory in Chrome (version 44) on
Android.

Refresh the page in this case, and
the list will be displayed. You can
then select an item and save the
record successfully.

QCCR1E127744 A few strings that are displayed in the
following user interface elements are not
translated:

There is currently no workaround
available.

l

l

Smart Analytics Assistant configuration
form and Time Duration Checkpoint form
in the upgrade environment
Upgrade Utility dialog boxes

QCCR1E127953 The string "has been acknowledged" in the To- There is currently no workaround
do Alert popup message is not translated.
available.
QCCR1E128218 When you are adding/modifying CI
relationships, the following Relationship Type
values are available for selection: Accesses,
Aggregation, ClientServer, Composition, and
so on, (which are correct values). However,
when you are viewing CI relationships in the CI
detail form, you can select only the following

HP Service Manager (9.41)
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Global ID

Issue

Workaround

Relationship Type values as a filter: All,
Logical, and Physical (which are no longer
used in Service Manager 9.41).
QCCR1E127567 The incident category "request for change" is
not localized in the Service Manager Hybrid
mode.

There is currently no workaround
available.

QCCR1E126631 When you select a value for a task category in
the task planner two times, only one value is
available the second time.

To see all list items, clean the
combo field and click the dropdown button again.

QCCR1E126641 Related record information for Phase, Status,
and Title in the Interaction details page is not
displayed until you exit the related Incident
session.

There is currently no workaround
available.

QCCR1E127857 An error that indicates the query field
"pd.enabled" in "upginfo" is not defined in
"dbdict" is generated when smupgrade is
invoked.

Purge data and reload preupg.bin
again after preupg.bin is loaded
for the first time.

QCCR1E119102 Internet Explorer 10 or 11 cannot open some
Service Manager pages, such as calendar and
dashboard pages, because of the pages
hanging and not loading. Additionally, when
you access one of these pages with the F12
developer tools open, an “Access is denied”
message appears on the console.

Restart your Windows operating
system.

This issue may occur when an automatic
Internet Explorer upgrade has happened in
the background, because both Internet
Explorer 10 and 11 have an Install new
versions automatically setting in the About
Internet Explorer dialog.
The Service Manager web tier uses the local
storage functionality of Internet Explorer. The
local storage file is stored under your user
profile folder (normally, it is
C:\Users\<username>\Appdata\LocalLow).
When Internet Explorer is upgraded, this
folder is probably protected, and any

HP Service Manager (9.41)

Page 18 of 58

Service Manager 9.41 Patch 2 Release Notes
Known issues, limitations, and workarounds

Global ID

Issue

Workaround

attempts to visit the local storage object will
throw a Javascript error.
QCCR1E115514 Auto-complete for the the comfill in the "Link
to Parent Incident" field in the Incident form
does not work correctly.

There is currently no workaround
available.

QCCR1E115283 The color indicator does not work for the field
that retrieves the values from the DVD.

There is currently no workaround
available.

QCCR1E113128 You cannot select the foreground color in
Color Indicator Setting by using the keyboard.

There is currently no workaround
available.

QCCR1E114911 Fields in ERDs that are duplicated in dbdict are
not displayed
There is currently no workaround available.
correctly.
QCCR1E116553 Truncation and overlapping of elements on
the details page of records occurs when you
use the vertical view.

Resize the details page to make it
wider or use the horizontal layout.

QCCR1E118066 Truncation and overlapping of elements on
the details page of the Missing Reference
Report occurs when you use the vertical view.

Resize the details page to make it
wider or use the horizontal layout.

QCCR1E117293 When you rebuild relationships in Relationship
Manager, link type relationships that have a
"fixed" status are removed.

There is currently no workaround
available.

QCCR1E115272 ERDs cannot be recovered when you open
another tab in the same browser.

There is currently no workaround
available.

QCCR1E93098

There is currently no workaround
available.

When you modify a problem record, and then
try to close the record whilst a backend
process modifies the record at the same time,
you are prompted with a message that asks
you to merge the conflict.
However, after the record is merged, you
cannot close the problem record.

QCCR1E118260 When you search for an incident, interaction,
or change in a heavily-populated database,
the operation takes more than 20 seconds.

HP Service Manager (9.41)
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Global ID

Issue

Workaround

QCCR1E116869 The primary key is lost after you change the
length of a field in a dbdict.

Manually recreate the primary key.

QCCR1E112005 Due to a limitation in Oracle 11g, records in
the patchrelresults and scmessage tables
that have a Primary Key cannot be unloaded
correctly in an Oracle 11g database.

Change the Primary Key of the
patchrelresults and scmessage
tables to a Unique Key before you
perform the unload.

QCCR1E119311 On Linux, if you run the server configuration
script (<SM installation
path>/Server/configure) on a graphic user
interface (GUI), an error occurs.

Run the script on a console by
using this command:

QCCR1E111068 When you click a Change model in the
navigation tree in Firefox, a TypeError occurs.

Use Internet Explorer or Chrome.

QCCR1E112202 When a workflow description tooltip contains
too many lines, the background color is
incorrectly displayed as white.

There is currently no workaround
available.

QCCR1E113131 When you save a record for which an
additional form is configured, the display
returns to the primary form.

There is currently no workaround
available.

QCCR1E115310 Hotkeys are not supported for menu items in
the workflows page.

There is currently no workaround
available.

QCCR1E115608 You cannot modify the option ID of workflowbased actions, and an option ID that
duplicates an ID in display options may be
generated.

Manually change the display option
ID.

QCCR1E115772 In Internet Explorer, the workflow viewer may
unexpectedly scroll right or down if you have a
scroll bar and the browser zooms in.

There is currently no workaround
available.

QCCR1E115828 You cannot expand or collapse the workflow
list folder by using the Space key. This
behavior is therefore not consistent with
accesibility behaviour in the standard client.

There is currently no workaround
available.

QCCR1E116043 The workflow viewer moves to next phase
incorrectly when an automatic transition is
blocked by an unclosed task.

Reload the record.

QCCR1E116343 The query editor may be launched with an

There is currently no workaround
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Global ID

Issue

Workaround

incorrect query record table name.

available.

QCCR1E116937 Requests that have an open request task
cannot transition to the next phase, but
activities can be saved.

There is currently no workaround
available.

QCCR1E117042 When you approve a record , and that
There is currently no workaround
approval triggers an automatic transition,
available.
open task validation is bypassed and the
automatic transition occurs even if open tasks
exist.
QCCR1E117154 There is no reminder to users that they must
set the table name of a rule set in order to
populate the "Group Field Name" and "Service
Field Name" drop-down lists in the Assignment
rule configuration form.

There is currently no workaround
available.

QCCR1E117366 The User Option condition does not work
correctly when the option value is an array
type.

In Condition Editor, set the value of
User Option UO1 = {"1"} instead of
User Option UO1 = "1"

QCCR1E118589 If you use the task editor to edit a task in a
change model, and then try to save the
change model, you receive a "The record being
updated has been modified since read" error
message.

Close the current change model
and open it again to update the
changes in the change model other
than the task editor changes.

QCCR1E118741 Inconsistencies can occur between Change
categories and "Open in Phase'/'Close by
Phase" tasks in change models.

Manually update the "Open in
Phase" and "Close by Phase" in
Task Planner.

QCCR1E117762 If you tailor the primary key in the inbox dbdict
before you perform an upgrade, an error
occurs during the upgrade process.

Return the primary key to its
original state.

QCCR1E117551 You receive the following error after you
upgrade Service Manager:

There is currently no workaround
available.

Invalid object name 'CM3RM2'
Note: Ignore this error if CM3RM2 is
created after the upgrade.
QCCR1E118790 The operators/groups in Approval Definition

HP Service Manager (9.41)
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Global ID

Issue

Workaround

are not correct after you upgrade to Service
Manager 9.41.

correct operators/groups to the
Approval Definition manually.

QCCR1E118814 Several secRights and secRole records are
suffixed by "_migrated" after you upgrade
Service Manager 9.3x (with Process Designer
applied) to Service Manager 9.41.

Manually remove the "_migrated"
suffix from the profile name.

QCCR1E118817 Some lines of links are suffixed by "_disabled_
by_PDRM" after you upgrade Service Manager
9.3x (with Process Designer applied) to Service
Manager 9.41.

Manually remove the lines of links
that are suffixed by "_disabled_
by_PDRM."

QCCR1E118821 Several records are suffixed by "_disabled_
by_PDRM" or "_disabled_by_PDHD" after you
upgrade Service Manager 9.3x (with Process
Designer applied) to Service Manager 9.41.

Manually remove the records that
have a "_disabled_by_PDRM" or "_
disabled_by_PDHD" suffix.

QCCR1E118823 Several records are suffixed by "_for_pd4_
tobe_used" after you upgrade Service
Manager 7.11, 9.21, or 9.3x to Service
Manager 9.41.

There is currently no workaround
available.

QCCR1E117439 The chm.cm3r.release.mobile form retrieves
members from the "COORDINATOR" group as
the Change Coordinator values. However, the
current data source table is "cm3groups,"
which is for Service Manager Classic.

Use the "assignment" table
instead of the "cm3groups" table
in Service Manager Codeless.

QCCR1E103336 There is no split line between the Updates tab
and the Approval tab in an Emergency Change
record when you use the Google Chrome
browser for Android.

There is currently no workaround
available.

QCCR1E117328 A Reject Reason is filed in the retraction page
with an empty Reject Reason option.

There is currently no workaround
available.

QCCR1E117598 The Array comfill is displayed as a black block
when you use the Mobile Applications in the
self-service user view.

There is currently no workaround
available.

QCCR1E115349 Items in the "My open Requests" and "My
Closed Requests" lists are not displayed in the

There is currently no workaround
available.
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Global ID

Issue

Workaround

correct order. The latest request to be
created does not appear at the top.
QCCR1E118626 Pictures attached to interactions are not
saved to the local gallery in IOS 8.1.1.

Use the Chrome browser instead
of Safari.

QCCR1E118509 The "not" condition is missing when you
perform hot topic analytics from a list.

There is currently no workaround
available.

QCCR1E118508 When you perform hot topic analytics from a
list, and the condition field is not in the IDOL
index, error messages are displayed.

There is currently no workaround
available.

QCCR1E118215 The Distributed Image Server does not
support large size images (over 1MB) in
concurrent user testing.

There is currently no workaround
available.

QCCR1E118907 Hot Topic Analytics does not support
accessibility as expected.

There is currently no workaround
available.

QCCR1E113455 The remote path and mapping path cannot be
set in the File Server Base Path if you do not
start Service Manager with administrative
privelages.

Start Service Manager as an
administrator.

QCCR1E102485 You cannot drill down into a pie chart that
uses a simple query.

There is currently no workaround
available.

QCCR1E104840 Only administrators can create a report on the
activity table of each module. However, if an
administrator creates and shares a report,
users who receive the shared report can
subsequently create reports.

Administrators can share reports
with users who need to create
reports.

QCCR1E116868 You cannot modify the order of pivot fields in
Hebrew in a dashboard or preview panel.

There is currently no workaround
available.

QCCR1E113689 You cannot export schedules to the file server
if the schedule name includes a question mark
("?").

There is currently no workaround
available.

QCCR1E103975 Daylight saving time is not supported by the
tochar() method in adhoc SQL.

There is currently no workaround
available.

QCCR1E102491 The partition color of charts with simple
queries is incorrect.

There is currently no workaround
available.
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Global ID

Issue

Workaround

QCCR1E109588 List reports cannot retrieve data from
replicated databases.

There is currently no workaround
available.

QCCR1E109691 Date/time values are not supported in multilevel "group by" fields.

There is currently no workaround
available.

QCCR1E110835 Reports that have long legend text do not
print as expected.

Shorten the legend label.

QCCR1E105868 Service Manager loads reports in a dashboard
one-by-one.

There is currently no workaround
available.

QCCR1E105815 Service Manager server CPU utilization is
higher than expected when the ToDo queue is
set as the landing page and the inbox size
exceeds 50K.

Check the inbox size periodically,
and control the size manually.

QCCR1E109576 When you export a report from the webtier,
Refresh the dashboard before
the report data and definition are fetched
exporting a report.
from server. Therefore, the exported and onscreen reports may differ if you have modified
the report data but not refreshed the screen.
QCCR1E118434 The temp file in the Tomcat temp directory
cannot be deleted after the session is closed.

There is currently no workaround
available.

QCCR1E106689 The list header of a view in the dashboard and
in the ToDo queue are not the same.

Define the list field to match the
qbe of the table.

QCCR1E109286 The whole pivot table report is exported when
you de-select some options in the filter.

There is currently no workaround
available.

QCCR1E112905 The report/Dashboard definition page is
displayed in the old style when you open it
from the favorites and dashboard area.

There is currently no workaround
available.

QCCR1E112573 Exported charts are inconsistent with the
charts in the browser because the export
function and the dashboard use different
rendering methods.

There is currently no workaround
available.

QCCR1E111387 "Title list" type reports are displayed with all
columns in the ToDo queue.

There is currently no workaround
available.

QCCR1E106640 Query conditions in the condition box and
condition builder are not consistent.

There is currently no workaround
available.
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Global ID

Issue

Workaround

QCCR1E118269 The JVM heap size for the report.export
thread needs to be at least 1024MB when the
export threads are configured to 10.

Set a dedicated Service Manager
instance for the reporting
schedule.

QCCR1E111234 You can export reports as a PDF only in the
system language font.

There is currently no workaround
available.

QCCR1E117603 The meaning of the text string "inbox" is not
always clear.

There is currently no workaround
available.

QCCR1E118983 If your SQL Server database uses Unicode with
a collation that does not support a specific
language (for example, Latin1_General_100_
BIN, which does not support Chinese), when
you create an HTML Template with a name
containing text in that language, save the
template and open the template again
through a search, the template name is
displayed incorrectly – characters in that
language are displayed as unrecognizable
text.

Click Tailoring > Database
Dictionary, search for
"htmltemplates," click the
htmlcode field, and then change
the SQL RC value to "true."

QCCR1E119106 If your SQL Server database uses Unicode with
a collation that does not support a specific
language (for example, Latin1_General_100_
BIN, which does not support Chinese), when
you create a knowledge document whose title
contains characters in the unsupported
language, the document is displayed correctly.
However, if you search in the Knowledge
Library using keywords from the document,
the document is returned in the search results
with characters in that language displayed as
unrecognizable text.

Click Tailoring > Database
Dictionary, search for
"kmknowledgebaseupdates,"click
the recdata field, and then change
the SQL RC value to "True."

QCCR1E89819

Modify the "operator" dbdict
manually to fix this issue. First,
create a new "a6" table in the SQL
Tables tab. Then, modify the value
of the "secRole" field from "m1" to
"a6" in the Fields tab for both
fields (array field and child field).

The "Request TCAB Approval" step in the
Normal Change workflow takes more than 100
seconds to complete when there are 6000
users in the database.

QCCR1E117326 The total cost of a Request, Incident, Problem,

HP Service Manager (9.41)
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your search results, perform a full
index against that library.
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Change, or task record is recalculated when
you update the cost information. Therefore,
when you update an operator’s hourly rate,
the historical cost of the record (that is, cost
that is already incurred) may also be updated
incorrectly.

available.

QCCR1E118616 The Create One Request Fulfillment Record
for each Device of Class X at location Y
effect option in Scheduled Maintenance does
not work correctly.

There is currently no workaround
available.

QCCR1E114145 If two items in a bundle have the same user
option name, only the last user option can be
referenced by the system for evaluation.

Do not use duplicate user options
for items in one service catalog
bundle.

QCCR1E117903 When you cancel a planned purchase task
before you finish creating it, validation of the
task still occurs.

There is currently no workaround
available.

QCCR1E113121 When you order a bundle without a connector,
and when this bundle contains a sub-bundle
with a connector, the connector that is
defined in sub-bundle does not take effect.

There is currently no workaround
available.

QCCR1E119273 The "Significant" and "KM Change" change
subcategories are not added during the
upgrade process.

Manually add the subcategories.

Deferred issues
Global ID

Problem Description

QCCR1E105815 Service Manager server CPU utilization is
higher than the benchmark during peak
time if landing page (dashboard) is
enabled.

HP Service Manager (9.41)

Deferral comment
The potential inbox size was validated
with customers in the early design
review phase. According to feedback
at the time, inbox sizes are not likely
to exceed 50,000 records in the next
two years. The CPU issue occurs only
when the inbox size exceeds the
restricted quantity. When the inbox
size is 100,000 records, the peak time
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Global ID

Problem Description

Deferral comment
database CPU% is 44%. When the
inbox size is 50,000 records, the peak
time database CPU% is 16%.

QCCR1E105868 The Service Manager server should support This is a legacy RTE issue; Service
more threads loading data simultaneously Manager does not support multiple
in one user session.
threads. Changing this requires a
major effort to redesign the whole
implementation.
QCCR1E100987 In the Mobile client, the user session count
increases until no new users can log in.

To work around this issue, add a
Service Manager servlet to increase
the maximum number of sessions.

QCCR1E111283 Every click on the Problem Hunter button
triggers a search of the IDOL server.

Deferred as there is limited impact,
according to current performance
testing results.

QCCR1E118210 Synchronous API calls to IDOL on Smart
Ticket OCR are not supported.

Deferred as OCR is a back-end task
which will not impact the experience
of end users.

QCCR1E118215 The Distributed Image Server does not
support large size images (over 1MB) in
concurrent users testing.

Deferred as over 96% of customers'
attached images are below 500KB.

QCCR1E111026 There is no warning message to access the
Restful API Service Doc if the
restaccessviabrowser parameter is not
enabled.

This is by design but will be changed in
a later release.

QCCR1E113589 The response time when a large number of
tasks is mass updated is longer than
expected.

There is a popup window to warn end
users that performance may suffer
when they update more than 10
tasks.

QCCR1E127817 Fulfillment Process should be configurable
for Legacy Service Desk workflow

Do not use this configuration for the
legacy Service Desk module. This is
only for streamlined interaction.
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Installation notes
This section provides instructions for installing each component in this patch release:
l

Server

l

Web tier

l

Windows client

l

Service Request Catalog (SRC)

l

Mobility client

For Service Manager 9.4x components that are not included in this release, you can find the download
links to their latest versions and specific release notes here.
Before you proceed, we recommend that you consult the latest Service Manager 9.41 Support Matrix.
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Backup and backout instructions
In case you need to restore your Service Manager system to its original state after installing the
component patches in this release, make necessary backups before each patch installation. If a rollback
is needed, follow the backout instructions.

Server
Backup
Before you apply the server patch, make a backup of the server installation folder. For example,
C:\Program Files\HP\Service Manager 9.41\Server.
Note: If you have a horizontally-scaled system, you must back up the server installation folder for
each server instance.

Backout
Service Manager has supported FIPS mode since version 9.32. To run Service Manager in FIPS mode, you
must upgrade your database to the 256-bit AES encryption algorithm. Once you change all of the
encrypted fields to use the new 32 character encryption you cannot roll back the RTE and still read the
encrypted data.
Follow these steps to back out the installation:
1. Stop the Service Manager server.
2. Remove the existing server installation folder.
3. Copy the backup folder back.

Note: Make sure that the embedded Tomcat is also replaced with the backup, because the
version of the embedded Tomcat may have dependency on a specific server version.

Note: If you have a horizontally-scaled system, make sure that every server instance is
replaced with its backup.
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4. If you have also loaded platform unload files required for your server changes, you must also roll
back the application changes made by the unload files. See "Applications" on the next page.
5. Restart the Service Manager server.

Web tier
Backup
Before you deploy the new web tier, back up the following items:
l

lwssofmconf.xml

l

web.xml file

l

application-context.xml

l

log4j.properties

l

splash screen

l

style sheets

l

The folder that is defined in the customize-folder parameter in the web.xml file

l

<webtier>\images\obj16\ folder

l

Any other customizations that you made, including your webtier-<version>.war (webtier-ear<version>.ear) file.

Backout
To roll back to the old web tier, follow these steps:
1. Delete or uninstall the existing web tier.
2. Clear the cache of your web application server (for example, Tomcat).
3. Redeploy the old web tier.
4. Restore your old customizations.

HP Service Manager (9.41)
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Windows client
Backup
1. Make a backup of your Windows client home folder. For example,
C:\Users\<username>\ServiceManager. Your connections and personalized settings are stored
in this folder.

Note: This is the out-of-the-box home directory, and could differ from yours if you made
changes to <Client>\configuration\config.ini file. If so, back up the files from the
location specified in that file.

2. Make a backup of your certificate configuration files if any (Window > Preferences > HP Service
Manager > Security). For example, your CA certificates file and client keystore file.
3. Make a backup of the following folder:
<Client>\plugins\com.hp.ov.sm.client.eclipse.user_
x.xx.xxxx\src\resources\icons\obj16\.

Backout
1. Uninstall the new Windows client.
2. Reinstall the previous Windows client.
3. Restore your old Windows connections and configurations.

Applications
If you plan to upgrade your applications to this patch level, make a backup of your database before the
upgrade, in case you need to restore your database after the upgrade. Creating a backup of the entire
database and restoring the database if needed is a better approach for a full applications upgrade.
If you plan to load individual unload files in this release, follow the backup and backout instructions
below.
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Backup
Tip: If your application version is 7.11 ap3, 9.21 ap3, 9.30 ap3, 9.31 or later, we recommended that
you use Unload Manager to make a backup of the files to be modified by an unload file, because
Unload Manager can create a backup of your old data during the installation of the unload. If your
application version is not listed above, Unload Manager is not available, and you can use Database
Manager instead.
To use Unload Manager to make a backup, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload to open the wizard.
3. Select the unload file you want to apply, also specify a backup file, and then click Next. Details of
the unload file appear.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to go back to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the unload.
7. Click Finish.
Now, the unload has been applied and at the same time your old data backed up.
To use Database Manager to make a backup, follow these steps:
1. Go to Database Manager, select Import/Load from More or the More Actions menu, and browse to
the unload file.
2. Click List Contents on the menu bar to view a list of files that have been updated in this unload.
See the following figure for an example.
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This figure shows the contents of an unload file that contains changes to the following files.
File

Record

Process

svc.add.cart

application

money.format
Note: The scmessage records listed under each RAD application are
messages used in this RAD application; no backup is needed for them.

ScriptLibrary svcCartHelper
datadict

activity

dbdict

activity
Note: The “activity” file with no records actually represents the dbdict record
of the activity file.

scmessage

The record whose message class is “fc” and message number is 1000.

3. Go to Database Manager, in the Table field enter a file name you got in step 2, and click the Search
button.
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4. If the format selection page shows, select the proper format by double-clicking it (for example,
select the device format for the device file), and then search for the file record.
5. Click More (or the More Actions menu) > Export/Unload after the file record is displayed.

Note: If Export/Unload is not available, check the Administration Mode check box in Database
Manager and try again.

6. In the pop-up window, specify your backup upload file path/name, and click Unload Appl.

Caution: Make sure that Append to file is selected.

7. Repeat steps 3 through 6 to back up the rest of the files you got in step 2.

Backout
Tip: You can use Unload Manager (recommended) or Database Manager (if Unload Manager is not
available in your application version) to roll back to your old data, as described in the following
instructions.
To roll back to your old data using Unload Manager, follow these steps:
1. Go to System Administration > Ongoing Maintenance > Unload Manager.
2. Double-click Apply Unload to open the wizard.
3. Select the unload file generated in the backup process, specify a backup file, and then click Next.
Details of the unload file are displayed.
4. Double-click a conflicting object in the table to open the merge tool:
a. Merge the object, and then select the Reconciled check box.
b. Click Save to return to the wizard.
5. Click Next after all the conflicting objects are reconciled.
6. Click Yes on the confirmation window to apply the backup unload.
7. Click Finish.
To roll back to your old data using Database Manager, follow these steps:
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1. Go to Database Manager, click More > Import/Load.
2. Browse to the backup unload file you created.
3. Click Load FG.

SRC
Backup
Before deploying new SRC war package, back up the following files if they have been customized:
l

WEB-INF/classes/applicationcontext.properties

l

WEB-INF/classes/lwssofmconf.xml

l

WEB-INF/classes/cacConfiguration.properties

l

WEB-INF/web.xml

l

Custom.properties

l

secure/configuration folder

Backout
To roll back to the old SRC, follow these steps:
1. Delete or uninstall the existing SRC.
2. Clear the cache of your web application server.
3. Redeploy the old SRC war package.
4. Restore your old customizations.

Solr Search Engine
To back out your Solr search engine changes, make a backup before your KM patch installation.
Note: Keep in mind that you also need to roll back KM-related server side and application side
changes. For details, see the Server and Application backup and backout Instructions.
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Backup
Before installing the KM patch component and upgrading the JDK and KM-embedded Tomcat, perform
the following tasks:
l

Make a backup of the search engine installation folder. For example, C:\Program
Files\HP\Service Manager 9.41\Search Engine Backup

l

Make a backup of the files to be modified by the unload files in the KM patch.

l

Make a backup of your schemastub.xml file under directory <SM server>/RUN/km/styles/.

Backout
After installing the KM patch, follow these steps:
1. Stop your Solr search engine.
2. Remove the existing search engine installation folder.
3. Copy the backup folder back.
4. Rollback the previous JDK installation and change the JAVA_HOME environment variable back.
5. Be sure to roll back KM related changes on the Service Manager server and application sides,
including the kmsolr unloads files and the server's schemastub file.
6. Restart your Solr search engine.
7. Perform a full re-indexing on all of your knowledgebases.

Digital signature notice
HP signs Windows executable files with a digital signature. Since January 2012, this process has been
updated to use a new VeriSign root certificate. On a Windows system that does not have the new
VeriSign root or intermediate certificate installed, when the user right-clicks the file and then goes to
Properties > Digital Signatures > Details, the following verification error is displayed:
The certificate in this signature cannot be verified.
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To resolve this issue, either enable Windows Update or download and install the G5 Root certificate as
documented at: https://knowledge.verisign.com/support/ssl-certificatessupport/index?page=content&actp=CROSSLINK&id=SO19140

Server update installation
The server update for your operating system consists of a compressed file, sm9.41.2003-P2_<OS>.zip
(or .tar), which contains updated files of the HP Service Manager server. These files add to or replace
the files in the [SM Server Root]\([SM Server Root]/)RUN, irlang, bin, legacyintegration, and platform_
unloads directories.
Note: If you use an Oracle RDBMS, be aware that Oracle Call Interface (OCI) 11.2.0.3 or later is
required for Service Manager. For more information, see the latest Service Manager 9.41 Support
Matrix at https://softwaresupport.hp.com/group/softwaresupport/support-matrices

Built-in troubleshooting tool (SM Doctor)
The server patch will install the HP Service Manager Doctor (SM Doctor) tool in the <SM server root>\
(<SMserver root>/)smdoctor directory. For information on how to use this tool, see the Guides and
reference > Troubleshooting > HP Service Manager Doctor section in the Help Center.
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Upgrade paths
This server patch must be applied on top of an earlier Service Manager 9.4x system.
The following server upgrade paths are recommended:
l

New customers: Install the Service Manager 9.40 GA server, and then apply this server patch.

l

Existing SC6.2, Service Manager 7.11/9.21/9.3x customers: Uninstall the old server, install the
Service Manager 9.40 GA server, and then apply this server patch.

l

Existing Service Manager 9.4x customers: Apply this server patch.

For installation instructions for the Service Manager 9.40 server, see the Service Manager 9.40
Interactive Installation Guide, which you can download from this site:
https://softwaresupport.hp.com/group/softwaresupport/search-result//facetsearch/document/KM01294561

JRE upgrade
For Windows and Linux, the server's embedded JRE is automatically upgraded to version 8 after you
apply the server patch; for other Unix-based platforms, you need to manually perform this JRE upgrade.
Before you proceed, pay attention to the following issues.

Preventing failure of external web service calls over SSL
The JRE upgrade will cause external web service calls over SSL to fail if the remote endpoint does not
support Server Name Indication (SNI), which is by default activated in JRE 8. Once Service Manager is
upgraded to use JRE 8, it starts to use SNI extensions during the SSL handshake. If the remote endpoint
does not support SNI, the web service call will fail with an error message.
To solve this issue, do either of the following:
l

Activate SNI at the remote end point (recommended)

l

If the remote endpoint does not support SNI extensions, SNI cannot be activated. In this case, add
the following JVMOption<n> parameter either to the sm.ini file, or to the start command of the
servlet(s) in the sm.cfg file:
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JVMOption2:-Djsse.enableSNIExtension=false (in sm.ini)
sm -JVMOption2:-Djsse.enableSNIExtension=false (in sm.cfg)

Running the server on Linux with JRE 8
If you are using a horizontal implementation on Linux, after you upgrade the server, you may not be able
to kill a locked session from the Show Locks format (system.status.locks.g). This issue occurs only when
JRE 8 is used and only on certain Linux versions.
If it occurs, perform the following steps for the hosts file of each server to the solve the issue:
1. Open the hosts file of your server host (/etc/hosts).
2. Comment out the following line: 127.0.0.1 localhost
That is, change the line to the following: #127.0.0.1 localhost
3. Make sure the hosts file specifies only one host name for your server's IP.
4. Repeat the steps above for the rest of the server hosts.

Server patch installation steps
Caution:
l

The server patch will upgrade your embedded Tomcat to version 6.0.44, and therefore requires
additional steps.

l

The server patch will upgrade your JGroups (in the RUN/lib directory) to version 3.2.

Note: If you have a horizontally-scaled system, you must upgrade all your server instances.
To install the new sever patch, follow these steps:
1. Stop all Service Manager clients.
2. Stop the Service Manager server.
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3. Make a backup of the Server installation directory. See also "Backup and backout instructions" on
page 29.
4. Delete the RUN/tomcat directory. Tomcat in this directory will be upgraded to a higher version
after the server patch is installed.
5. Delete the RUN/lib directory.
6. (For Windows and Linux platforms only) Delete the RUN/jre directory.

Note: This is to avoid conflicts between the old JRE and new JRE.

7. Extract the compressed files for your operating system into the main Service Manager directory on
the server.
8. (For UNIX servers only) Set the file permissions for all Service Manager files to "755."
9. For the following Unix servers, manually upgrade to one of the following JRE versions, if you have
not already done so.
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a. Install an appropriate version of JRE for your platform.
HPUX

JRE 8 (JRE_8.0.03 or greater)

AIX

JRE 8 (SR1FP10)
Caution: To use JRE 8, your AIX version must be one of the following:
l

AIX7 7100-03 or later

l

AIX6 6100-07 or later

Note: You can check the JRE version on AIX by running the $<JRE_INSTALL_
DIR>/bin/java -version command, in which <JRE_INSTALL_DIR> is the
JRE installation directory. Make sure that the system output consists of the
following line:
Java(TM) SE Runtime Environment (build pap3280sr1fp10ifix20150723_01(SR1 FP10+IV75420))
Sola
ris

JRE 7 (update 80 or greater)

b. Set your JAVA_HOME environment variable to point to the correct JDK (if you have JDK
installed) or JRE (if you have only JRE installed).
c. Execute \RUN\removeLinks.sh to remove the old symbolic links and then execute
\RUN\setupLinks.sh to create new symbolic links.
d. Run the following command to check that the JRE version is correct:
RUN\jre\bin\java –version
10. If you have made any customizations/changes to the original RUN/tomcat folder, restore them in
the new RUN/tomcat folder.
11. Your old schemastub.xml file (in the <SM_Server_Home>\RUN\km\styles\ directory) has been
updated to a newer version. Either keep your old file by copying it back or keep the updated
version (a full reindex for the knowledgebases is then required).
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12. Run the sm -unlockdatabase command.

Note: This step is required the first time you upgrade to 9.30p4 or later; it is also required
whenever you change the server’s IP address after your upgrade to 9.30p4 or later. The
purpose of this step is to prevent stale license information from being kept in the system. In a
scaling implementation, you can run this command from any one of your servers.

13. Restart the Service Manager server.
14. Restart the Service Manager clients.
15. Verify the version using either of the methods:
o

From the Windows client, click Help > About Service Manager Server. The server version should
be:
Release9.41.2003 build P2

o

From the server's RUN folder, run the sm -version command. The server version should be:
Version: 9.41.2003
Patch Level: P2

Web tier installation
The web tier update consists of a compressed file, sm9.41.2003-P2_Web_Tier.zip, which contains the
installation files (both the .war and .ear files) that are required to install the HP Service Manager web
tier. Installing the new web tier will upgrade your web client to this release level.
For detailed deployment steps, see the Service Manager9.41 Interactive Installation Guide, which is
available to download from here.
Note: Service Manager 9.41p1 adds support of JBoss EAP 6.4. For information on how to deploy the
web tier on JBoss, see "Deploying the web tier on JBoss EAP 6.4" on page 44.
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New customers
You only need to install the new web tier using the .war or .ear file from the sm9.41.2003-P2_Web_
Tier.zip file in this release.

Existing customers
To upgrade your web tier to this patch level, you must back up and uninstall your old web tier, and then
install the new web tier. To keep your custom changes, you must back up your customized files and then
merge your customizations into the new deployment.
To install the new web tier, follow these steps:
1. Make the necessary backups. For more information about how to do this, see Web tier backout
instructions.
2. Delete or uninstall the existing web tier .war (or the .ear) file.
3. Clear the cache of your web application server.
4. Deploy the new webtier-9.41.war file or webtier-ear-9.41.ear file.

Note: It is best practice to deploy with a unique context root. For example, /webtier-9.41.

5. Use a diff utility to compare the new web tier’s web.xml file against your backed-up version to
ensure that any new parameters are properly merged into the files used in your final deployment.
Do this for application-context.xml as well as any other files you may have customized (such as
style sheets and splash screens).
6. Make any new customizations that are necessary for your deployment.
7. Restart the web application server.
8. Check the version by clicking the HP logo (About HP Service Manager) icon.
The web tier version should be: 9.41.2003-P2.
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Deploying the web tier on JBoss EAP 6.4
As of version 9.41p1, the Service Manager web tier adds support for JBoss. Currently, the supported
version is JBoss EAP 6.4.
Note: The following steps are for Windows. The steps for other operating systems are similar.
To deploy the web tier on JBoss EAP 6.4, follow these steps:
1. Download and install Oracle JDK 1.8 from the Oracle web site.
2. Set the JAVA_HOME environment variable to your JDK 1.8 installation directory.
3. Download the binary version of JBoss EAP 6.4 from the JBoss website.
4. Extract the JBoss package to a local directory.

Tip: For more information about JBoss deployment, refer to the %JBOSS_
HOME%\standalone\deployments\README.txt file.

5. Add the JBOSS_HOME environment variable, and set it to the JBoss installation directory (see step
4).
6. Make the following changes to JBoss.
a. Add the following path entries (which are highlighted in red) to the %JBOSS_
HOME%\modules\system\layers\base\sun\jdk\main\module.xml file :
<dependencies>
<system export="true">
<paths>
<path name="com/sun/org/apache/xalan/internal/xsltc"/>
<path
name="com/sun/org/apache/xalan/internal/xsltc/dom"/>
<path
name="com/sun/org/apache/xalan/internal/xsltc/runtime"/>
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<path name="com/sun/org/apache/xerces/internal/dom"/>
<path name="com/sun/org/apache/xerces/internal/jaxp"/>
<path name="com/sun/org/apache/xerces/internal/util"/>
<path name="com/sun/org/apache/xml/internal/dtm"/>
<path name="com/sun/org/apache/xml/internal/dtm/ref"/>
<path
name="com/sun/org/apache/xml/internal/serializer"/>
...
</paths>
<exports>
<include-set>
<path name="META-INF/services"/>
</include-set>
</exports>
</system>
</dependencies>

b. In the %JBOSS_HOME%\modules\system\layers\base\javax\xml\jaxpprovider\main\module.xml file, comment out the "xalan" dependency:
<module xmlns="urn:jboss:module:1.1" name="javax.xml.jaxp-provider">
<dependencies>
<!--<module name="org.apache.xalan" services="import"/>-->
<module name="org.apache.xerces" services="import"/>
<module name="org.codehaus.woodstox" services="import"/>
</dependencies>
</module>
c. In the %JBOSS_HOME%\modules\system\layers\base\javax\ws\rs\api\main\module.xml file,
comment out the "resteasy" dependency:
<dependencies>
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<!--<module name="org.jboss.resteasy.resteasy-jaxrs"
services="export"/>-->
</dependencies>
d. In the %JBOSS_HOME%\standalone\configuration\standalone.xml file, comment out the
extension and subsystem reference (according to the specific JBoss launch mode):
...
<!--<extension module="org.jboss.as.jaxrs"/>-->
...
<!--<subsystem xmlns="urn:jboss:domain:jaxrs:1.0"/>-->
7. Extract the webtier-9.41.war file to a folder. For example, a folder named webtier-9.41.
8. Rename the webtier-9.41 folder to webtier-9.41.war.
9. Make necessary changes to the web.xml located in the webtier-9.41.war/WEB-INF/ directory.
10. Copy the webtier-9.41.war folder to %JBOSS_HOME%\standalone\deployments\ folder.
11. Open your operating system command prompt, and execute the following command to create a
deployment marker file:
echo>> %JBOSS_HOME%\standalone\deployments\webtier-9.41.war.dodeploy
The filesystem deployment scanner in JBoss EAP 6 relies on this marker file, which serves as a sort
of command, to deploy or redeploy the web tier content.
12. Start JBOSS manually from the %JBOSS_HOME%\bin directory by clicking the standalone.bat file.
13. Wait until webtier-9.41.war.dodeploy in the %JBOSS_HOME%\standalone\deployments\ directory
is changed to webtier-9.41.war.deployed.
14. Launch the web client URL to test the connection.
For example, test with this URL: http://localhost:8080/webtier-9.41

Note: The JBoss communications ports are defined in the %JBOSS_
HOME%\standalone\configuration\standalone.xml file. The default HTTP port is 8080.
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Configuration notes for the user experience improvements
in the web client
Sidebar mode
The sidebar mode only works in Power User view (index.do) and Employee Self-Service view (ess.do), but
does not work in Accessible view (accessible.do) and Self-Service Accessible view (accessible_ess.do).
Accordion mode
When you deploy the Service Manager 9.4x web client together with a version of the Service Manager
applications that is earlier than 9.40, you need to perform the following actions:
l

You must install the QCCR1E114612_SM940_SM930.unl file. Otherwise, the System Navigator does
not work.

l

We recommend that you set the Enablesidebarmenu parameter to "False" to disable the icons and
the sidebar mode of the System Navigator. Otherwise, the Service Manager web client uses the
default icon for all menu items.

Quick help
Service Manager 9.40 or later moves the keyboard shortcut configurations from the web.xml file to the
shortcut.xml file, which is located in the web tier's WEB-INF folder.
If you have customized keyboard shortcuts in a previous version of Service Manager and you upgrade to
Service Manager 9.40 or later, you must move the keyboard shortcut configurations from your old
web.xml file into the shortcut.xml file. Otherwise, your customized keyboard shortcuts do not work. For
more information about how to configure the shortcut.xml file, refer to the following online help topic:
System Administration > Tailoring > Web tier > Editing Web client Key bindings
If the configuration of the shortcut.xml file is incorrect, the shortcut list displays an error message.

Windows client installation
Note: No features are being added to the Service Manager Windows (Eclipse) client. We
recommend that Service Manager administrators deploy one of the other three clients (web client,
SRC client, or Mobility client) to end users. You still need the Windows client to perform
administrative tasks.
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The Windows client update consists of a compressed file, sm9.41.2003-P2_Windows_Client.zip, which
contains the executable installation files of the new Windows client. Installing the new Windows client
will upgrade your Windows client to this patch level. This version of the Windows client comes with an
updated version of JRE 8.
For installation instructions, see the Service Manager9.41 Interactive Installation Guide, which is available
to download from here.
Note: The Windows client installer will also install the Client Configuration Utility in the <Service
Manager installation path>\Client\ClientConfiguration directory. To run the utility, double-click the
confutil.bat file in this directory. However, we recommend that you use the web client if you want to
provide end users with a customized client.

New customers
You only need to install the new Windows client.

Existing customers
You need to back up and uninstall the old Windows client, and then install the new Windows client.
To install the new Windows client, follow these steps:
1. Stop the Service Manager Windows client.
2. Make necessary backups. For details, see Windows client backout instructions.
3. Uninstall the Service Manager Windows client. (Your connection and personalized settings are
retained.)
4. Run setupclient.exe to install the new client.
5. Check the version in Help > About Service Manager Client.
The client should be Release: 9.41.2003-P2.
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Applications Update installation
This release does not contain an applications or upgrade package. The latest applications version is
9.41. An applications upgrade is optional, and you can install the Service Manager 9.41 Applications or
Upgrade package according to your current applications version.
You can find the SM 9.41 Applications or Upgrade package as well as HP Service Manager 9.41 Release
Notes in the Service Manager 9.41 installation media.

Application Unload installation
Note: All unload files in the server’s platform_unloads directory in this release have been already
merged into Service Manager applications 9.41 . These files are provided just in case you do not
plan to upgrade to applications 9.41 while still want to take advantage of the relevant new features
or fixes. Unload files included in this release are for Service Manager 9.3x applications, because the
server and clients in this release do not support applications versions earlier than 9.3x. For the
specific applications version to which each unload applies, see the "Applicable applications version"
column in the following table.

Unload Files Included in the current patch
This release includes the following unload files.

Unload
QCCR1E99207_
SM940_
SM930.unl

Applicable
applications
version
Description
9.3x (9.30 or
later)

Enables Service Manager to lazy load global lists. This reduces the
login time in environments that contain a large number of global
lists.

QCCR1E124742_ 9.3x (9.30 or
SM941_
later)
SM930.unl

Merges the module configuration requests that are sent from the
web client to the server during the login process. This helps to
reduce the login time.

QCCR1E129332_ 9.40
SM941_
SM940.unl

Enables you to enter values in fields that are made from a global
list when you use the 9.41 web client together with the 9.40 RTE
and applications.
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Unload

Applicable
applications
version
Description

QCCR1E129149_ 9.41
SM941P2_
SM941.unl

Enables To-Do Alerts to be automatically acknowledged without the
user having to click the Acknowledge button.

QCCR1E118520_ 9.3x (9.30 or
SM940P3_
later)
SM930.unl

Enables the enhanced query hash algorithm for the web client.

QCCR1E118520_ 9.40
SM940P3_
SM940.unl

Enables the enhanced query hash algorithm for the web client.

QCCR1E112070_ 9.3x (9.30 or
SM940_
later)
SM930.unl

For Service Catalog User Selection multi-selection support.

QCCR1E112070_ 9.3x (9.30 or
SM941_
later)
SM930.unl

For Service Catalog User Selection multi-selection support.

QCCR1E112815_ 9.34
SM940_
SM934.unl

Fixes an issue in which Time Period Management menus are not
displayed correctly due to incorrect menu condition settings.

QCCR1E19946_
SM940_
SM930.unl

9.3x (9.30 or
later)

Enables extra columns in the "Attachments" section of records.

QCCR1E31324_
SM940_
SM930.unl

9.3x (9.30 or
later)

Fixes the issue that with Syslog audit turned on only a syslog record
showing login is created and no record for logoff is recorded if the
user does not log out "normally."

QCCR1E31941_
SM940_
SM930.unl

9.3x (9.30 or
later)

Enables users to use a pre-configured decimal symbol when they
complete numeric fields.

QCCR1E52767_
SM940_
SM930.unl

9.3x (9.30 or
later)

Fixes the issue that users cannot add data policy definitions on
joined tables.

QCCR1E67072_
SM940_
SM930.unl

9.3x (9.30 or
later)

Enables users to take advantage of the new KMStatusListener
background process.
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Unload

Applicable
applications
version
Description

QCCR1E67610_
SM940_
SM930.unl

9.3x (9.30 or
later)

Enables you to block potentially dangerous attachments from being
submitted to Service Manager through the clients (Windows, web,
or web services).

QCCR1E67647_
SM940_
SM930.unl

9.3x (9.30 or
later)

Updates the exception message that occurs in the request
response when closing an interaction by calling CloseInteraction
from a web service without specifying the localSolution field in the
request.

QCCR1E70163_
SM940_
SM930.unl

9.3x (9.30 or
later)

Fixes the issue that the KMUpdate process terminates abnormally.

QCCR1E71099_
SM940_
SM930.unl

9.3x (9.30 or
later)

Enables a QBE list to display Value Lists instead of the data directly
retrieved from the database when you add a field by using Modify
Columns.

QCCR1E71139_
SM940_
SM930.unl

9.3x (9.30 or
later)

Solves the issue that when Service Manager is configured to use
LDAP as the authentication data source, the user is still forced to
change the password if the user's password has expired in the local
database.

QCCR1E73452_
SM940_
SM930.unl

9.3x (9.30 or
later)

Enables Mandanten restricting queries to be updated correctly
after a profile is edited.

QCCR1E76724_
SM940_
SM930.unl

9.3x (9.30 or
later)

Fixes an issue in which a "Signal 11" error occurs when an IR
regeneration is performed after the unique key of cm3r is deleted.

QCCR1E76796_
SM940_
SM930.unl

9.3x (9.30 or
later)

Provides the ability to turn on debugging dynamically for user
sessions or schedulers.

QCCR1E78794_
SM940_
SM930.unl

9.3x (9.30 or
later)

Removes incident.assignee when a Web Service call specifies the
assignee as 'NULL' through theService Manager 9.31 Mobility client.
Note: This unload is not needed for the Service Manager 9.32
or later Mobility client.

QCCR1E99147_
SM940_

HP Service Manager (9.41)

9.3x (9.30 or
later)

Fixes an issue in which the first tab of a Notebook is reset to be the
active tab when a new interaction is opened through the "Return to

Page 51 of 58

Service Manager 9.41 Patch 2 Release Notes

Unload

Applicable
applications
version
Description

SM930.unl
QCCR1E99398_
SM940_
SM930.unl

blank interaction" environment settings.
9.3x (9.30 or
later)

Enables the inactivity timer function to work correctly when the
Service Manager applications version is lower than the server
version.

QCCR1E103456_ 9.3x (9.32 or
SM940_
later)
SM932.unl

Enables the "Any of these words" text search option when you
export records to Excel or to a text file.

QCCR1E103581_ 9.3x (9.32 or
SM940_
later)
SM932.unl

Adds support for the auto-complete feature in the web client.
Note: After loading this unload file, you still need to perform
the following tasks to enable auto-complete for a specific
Comfill field in a form:
1. Make sure that the comfillAutoComplete parameter is set
to true in the web tier configuration file (web.xml). The
default value is true.
2. Make sure the Auto Complete property of this field is
enabled in Forms Designer. By default, this property is
disabled.

QCCR1E106292_ 9.3x (9.30 or
SM940_
later)
SM930.unl

Enables caching of the globallist and locallist files.

QCCR1E112012_ 9.3x (9.31 or
SM940_
later)
SM931.unl

Solves the issue that PD Framework components (including
Condition Editor , Query Editor , Workflow Editor, and Task Planner)
do not work correctly if an earlier version of the applications is
running on the 9.40 RTE and web tier.
Note: This unload is required if you are running 9.3x
applications on the 9.40 platform.

QCCR1E114612_ 9.3x (9.30 or
SM940_
later)
SM930.unl
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Unload

Applicable
applications
version
Description
upgraded by loading this unload file so that these features can
work correctly.
Note: This unload is required if you are running 9.3x
applications on the 9.40 platform.

How to load an unload file
Tip: If your application version is 9.30 ap3, 9.31, or a later version, we recommend that you use
Unload Manager to load an unload file, because Unload Manager can help you create a backup of
your old data and reconcile conflicts during the installation of the unload. If you are running an
application version that is not one of these, Unload Manager is not available, and you can use
Database Manager instead.
For detailed steps, search for the following topic in the online help: Load an unload file.

Service Request Catalog (SRC) installation
Service Manager 9.41p2 includes the SRC package (src9.41p2.0017.zip), which contains:
l

The SRC deployment file (src-9.41p2.war)

l

Unload files for SRC 9.41.p2 and for previous versions

Unload file naming convention
The unload files use the following naming convention: <CR_ID>_SRCxxxPxx_SMxxx.unl, where:
l

<CR_ID>: The identification number of the applications defect that the unload file fixes. For example,
QCCR1E12345.

l

SRCxxxPxx: The minimum SRC patch level that requires the unload file. For example, SRC940p1,
which means the unload file comes with the SRC9.40 patch 1 and should be used for patch 1 or
higher.
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l

SMxxx: The Service Manager applications version that requires the unload file. For example, SM941,
which means the unload file is intended only for Service Manager applications version 9.41.

Unload files included in the SRC 9.41 patches
The following unload file is included in the SRC 9.41 patch releases.

Unload file
QCCR1E126562_
SRC941P2_
SM941.unl

Introduced
in which
patch

Used for
apps
version(s)

SRC 9.41
p2

SM 941

Description
Enables SRC to support both Process Designer-based
requests and non-Process Designer-based quotes
simultaneously.

Note: In this release, the English version of the online help is updated for Service Request Catalog
9.41, while the localized versions are still based on SRC 9.32.
Before you proceed, read the Service Request Catalog 9.41 Interactive Installation Guide and the Service
Request Catalog 9.41 Customization Guide, which are available to download from here.
Note: Users who want to use Service Request Catalog on their tablet devices can download the
HP Service Request Catalog app to their device from Google Play or the Apple App Store. To locate
these apps, search for "HP SRC" in the appropriate store.
The HP Service Request Catalog 9.41 tablet app supports Service Request Catalog versions 9.33
through 9.41p2.

New customers
1. Deploy the src-9.41p2.war file by following the instructions in the Service Request Catalog 9.41
Interactive Installation Guide.
2. Configure SRC 9.41p2 by following the instructions in the Service Request Catalog 9.41
Customization Guide.

Existing customers
1. Install SRC 9.41p2, as described above.
2. Migrate your customizations from the old deployment to SRC 9.41p2.
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Mobility client installation
Service Manager 9.41p2 includes a compressed file (sm9.41.2000-P2_Mobility.zip), which contains the
following files:
l

Mobility client installation file (webapp-9.41.2000.war)

l

Mobility client self-service interface unload (MOBILITY_ESS_SM941_SM932.unl)

l

Unload to fix the issue in QCCR1E123225 (QCCR1E123225_SM941P1_SM932.unl)

l

Unload to fix the issue in QCCR1E125623 (QCCR1E125623_SM941P1_SM930.unl)

New customers can directly install the new Mobility client by deploying the webapp-9.41.2000.war file,
while existing customers must uninstall their old Mobility client and then install the new one.
The Mobile ESS module is included in the Service Manager 9.40 or later applications, but not in earlier
versions of the Service Manager applications that are supported by the Service Manager 9.4x platform
(that is, Service Manager 9.34, 9.33, or 9.32). The .unl file is provided for customers running an older
version of the Service Manager applications who want to use the Mobile ESS module.

Installation steps
Note: The Service Manager 9.41p2 Mobility client supports Apache Tomcat 7.0 and 8.0 web
application servers. Additionally, it can only work with Service Manager server 9.40 or later and
applications 9.32 or later.
For more information about how to install the Service Manager 9.41p2 Mobility client, refer to the
Service Manager 9.41 Mobile Applications User Guide, which you can access from here.

Enabling the Mobility self-service interface when running applications 9.32, 9.33, or 9.34
The Service Manager 9.41p2 Mobility client comes with a self-service user interface. However, if you are
running the 9.32, 9.33, or 9.34 applications, you must load the MOBILITY_ESS_SM941_SM932.unl file to
enable this interface. For instructions on how to load an unload file, see "Application Unload installation"
on page 49.
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Additional information

Additional information
l

Service Manager 9.41 Installation and Upgrade Documentation Center (for detailed instructions on
how to install Service Manager, including all backup and backout procedures)

l

Service Manager Support Matrices

l

As always, we encourage you to actively participate in making Service Manager better. Please follow
us on Twitter at @HPITSM, join our LinkedIn group "HP ITSM," or join the discussion on our blog.
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Send Documentation Feedback
If you have comments about this document, you can contact the documentation team by email. If an
email client is configured on this system, click the link above and an email window opens with the
following information in the subject line:
Feedback on Service Manager 9.41 Patch 2 Release Notes (Service Manager 9.41)
Just add your feedback to the email and click send.
If no email client is available, copy the information above to a new message in a web mail client, and
send your feedback to ovdoc-ITSM@hp.com.
We appreciate your feedback!
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